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MoDUL 6
DRIVE TEST 4G LTE

1. TUJUAN
a. Mahasiswa mampu mengoperasikan software Genex Probe dan beberapa tool lainnya untuk

melakukan drive test jaringan 4G LTE

b. Mahasiswa mampu mengukur beberapa parameter KPI jaringan 4G LTE yang meliputi

accesshility, retainability, mobility dan integrity

c. Mahasiswa mampu menganalisa hasil drive berupa data logfile menggunakan software Genex

Assistant

2. DASAR TEORI
2.1 Drive Test 4G LTE

Drive test merupakan salah satu bagian pekerjaan dalam optimasi jaringan radio. Drive

test bertujuan untuk mengumpulkan informasi jaringan secara real di lapangan. Informasi yang
dikumpulkan merupakan kondisi aktual radio frequency (RF) di suatu eNodeB.

Drive Test Team collect
user Experience data with

= ¢

Gambar 1. Pengum_pulan data dengan aktivitas Drive Test

Secara umum tujuan kegiatan Drive Test 4G LTE ini adalah untuk mengumpulkan informasi
jaringan radio frequency secara real di lapangan. Dimana informasi yang diperoleh dapat
digunakan untuk mencapai tujuan-tujuan berikut ini :

a.
b.

C.
d.

e
f.

Mengetahui coverage sebernarnya di lapangan, apakah sudah sesuai dengan coverage
prediction pada saat perencanaan

Mengetahui parameter jaringan di lapangan apakah sudah sesuai dengan parameter
perencanaan

Mengetahui adanya inteferensi dari eNodeB tetangga

Mengetahui adanya RF issue, sebagai contoh berkaitan dengan adanya drop call atau blocked
call

. Mengetahui adanya poor coverage

Mengetahui performansi jaringan kompetitor (benchmarking)

Perangkat yang dibutuhkan untuk melakukan DT diantaranya :

@roo0 o

Laptop

Software Drive Test (pada modul ini digunakan Genex Probe)

Modem 4G LTE yang berkerja pada frekuensi 900, 1800 dan 2300 MHz

LTE SIM Card

GPS receiver

Peta Maplinfo

Data engineer parameter atau Cellfile

Data engineer berisi Nama Site, Koordinat (Longitude dan Lititude), PCI, ENodeBID,SectorlID,
Local ID, Cell ID, Azimuth dan EARFCN
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LTE Dongle

Notebook

GPS
Gambar 2. Drive Test Tools

Beberapa hal yang diukur saat drive test antara lain :
a. Mengamati parameter QoS KPI pada 4G LTE meliputi
- Accessibility
Kemampuan user mengakses jaringan untuk menginisialisasi komunikasi dengan melihat
nilai ERAB Success rate (%), LTE RRC Setup Success (%), Call Setup Success Rate(%), LTE
Attach Success Rate (%), Service Request (EPS) Success Rate(%)
- Retainability
Bagaimana menjaga jaringan pada performansi yang bagus. Parameter retainability dapat
dilihat dari nilai Service Drop Rate(%)
- Mobility
Bagaimana pengguna dapat bergerak dengan mudah dari suatu tempat ke tempat lain
tanpa terjadi pemutusan hubungan. Mobility performance dapat dilihat berdasarkan nilai
Intra Freq HO Attemp Success Rate (%), Intra Freq HO Success Rate (%)
- Integrity
Bagaimana trafik besar di dalam jaringan
Pada jaringan 4G LTE yang termasuk dalam kategori integrity adalah nilai MAC Troughput
UL dan DL Avg (kbit/s)
b. Mengamati parameter pada Drive Test 4G LTE meliputi
- RSRP (Reference Signal Received Power)
- SINR (Signal-to-Noise Ratio)
- Throughput
- Call drop

3. Peralatan Yang Digunakan
a. Laptop dengan sistem operasi Windows
b. Software Genex Probe V3.5
c. GPS Receiver
d. Mode 4G LTE UE E392 Huawei

4. Langkah Percobaan
Pada percobaan ini untuk drive test jaringan 4G LTE digunakan tool Genex Probe.
A. Instalasi Genex Probe
1. Ekstrak folder Genex Shared dan jalankan file aplikasi setup. Pilih next dengan pilihan
default
2. Ekstrak folder Probe-Hard-Version dan jalankan file aplikasi setup. Pilih next dengan pilihan
default
3. Apabila genex probe sudah terinstal dengan baik, buka aplikasi genex probe dengan tampilan
awal seperti di bawah ini
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B. Drive Test 4G LTE
1. Konfigurasi DT Tool

Pasang modem 4G LTE yang digunakan pada laptop. Lakukan instalasi modem, apabila
modem 4G LTE masih belum dikenal oleh PC/laptop. Setelah instalasi modem, buka device
manager untuk menentukan apakah modem sudah dikenal dan diketahui nomor port
modem.
? Ports (COM &LLPT)

[ 15" Communicatiens Port (COML)
15" HUAWEI Mobile Connect - Application Interface (COM23)
75" HUAWEL Mobile Connect - PC Ul Interface (COM21)
TS Prolific USB-to-Serial Comm Port (COM24)
Berdasarkan tampilan device manager di atas terlihat bahwa modem 4G LTE terpasang
pada port COM23 sebagai COM Port.
Pasang GPS Receiver GlobalSat G-STAR IV pada laptop. Lakukan instalasi GPS, apabila GPS
masih belum dikenal oleh PC/laptop. Setelah instalasi GPS, buka device manager untuk
menentukan apakah GPS sudah dikenal dan diketahui nomor port GPS.

473 Ports (COM & LPT)
T3 Communications Port (COMI1)
75" HUAWET Mobile Connect - Application Interface (COM23)
? HUAWEI Mobile Connect - PC Ul Interface (COM21)
- ? Prolific USB-to-Serial Comm Port (COM24)
Berdasarkan tampilan dewce manager di atas terlihat bahwa GPS terpasang pada port
COM24.
Lakukan konfigurasi perangkat modem dan GPS. Pilih Configuration > Device Management >
Device Configure

3 DTaml) - [Device Configure]

n  View Test Window Help
i) e 0l PHies Podd «
AEIRELAN

Name Modzl ComPort ModemPort State
GPS

MS

Scanner

Untuk menentukan device yang digunakan, klik bagian MS > pilih icon Add > Tentukan tipe
modem yang digunakan dengan memilih pada pilihan Model
==

Add Device

Name: st
Type:  [us =
Modek -

Pada percobaan ini digunakan tipe Modem Huawei E392
Klik Next dan tentukan baud rate dan COM yang digunakan.
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Nilai Boud rate : 38400, COM Port : COM23 (sesuai pada device manager), Modem Port :

COM22

= Konfigurasi GPS dilakukan dengan klik bagian GPS > pilih icon Add > pilih model NMEA
[S=2

= Pilih Next dan gunakan baud rate 4800 dan COM Port COM24 (sesuai pada device manager)

> 0K

Add Device [
Name: MS51
Type: s
Model: [roawerezssz |
Baud rate: 33400 hd
oM port: [covs =]
Modem port: -

(Canfigure the modem port for PS tests or send AT
commands.)

Filter...
<ok Conce

Add Device

Name: [gp51

Typet  [gps -
8. &
concel

Add Device ﬂ
Name: T
Type: aps

Model: T
Baud rate: 2500 -
COM port: e -

Mogemport: [T ]
Adjust antenna:

(Configure the modem port for PS tests or send
AT commands.)

Liere. |
<Back Cancel

= Untuk mempermudahkan proses konfigurasi device dapat menggunakan icon Autodetct
= Kondisi masih Down, pilih icon connect untuk mengkoneksikan modem dan GPS.

1553 Device Configure =R =
EEE: ] o
Hame Model ComPont ModemPot State
-/ GPS
GPS1 HNMEA CoM24 Do
= M5
M31 HUAWEIE392 COM23 coMzz Domn
Scarner

Setelah ditekan tombol connect maka statusnya menjadi connected.
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2. Memasukkan Data Parameter
= Pilih Configuration > Engineer Parameter Management > Pilih Open

= Browse file Engpar 4G LTE yang sudah disediakan > Pilih System LTE > Next
CoE o & e e
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S Hetwort
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Select Fle
Sywaa: LTE x
[EDsta o\Engosr DTATE | Browse. |
™ Corfis Nehbomy Cel & i
. I o |

B Heot > Wel'

Set LocalCelllD pada Excel Parameter dan Local CelllD pada Probe Parameter > Finish

SREEICTE -
Excel Parameter Probe Parameter -
eNodeEID eNodeEID
eNodeBNams eNodsBName
SectorlD SectorlD
LocalCellD .
CellD CellD
EARFCN EARFCN
Pl FCI
Latitude Lattude
Longitude Longituds
Agimuth Adimuth
EDownTit . >
< | »I_I
Match.. Cancel | Customize.. |
™ Import Engineering Parameter by Area Edit

<Back I Finish I Cancel
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Match Parameters [

Selectshest:  [CalDam =

Excel Farameter Prabe Farameter -

eNodeBID eNod=BID

eNodeEName eNodeEName

SectorlD SectarlD
b LocaiCellD Local CellD

CellD ToD

EARFCH EARFCN

PCI PCl

Latiude Latitude

Longtude Longtude

Azimuth Adimuth

EDownTit . -
2l | »

Watch Cancel | Customize |
I Impart Engineering Parameter by Area
< Back Firish Cancel |

= Apabila berhasil maka muncul data engineer parameter seperti di bawah ini

[5] Engineering Parameter Management =N ECR =]
SsEBEYE

Rowlndex  eNodeBID  eNodeBName  SectorlD CellD EARFCN PCI Longtude  Lalitude Azimuth Local CllD TAC il

1 505103 C_COF103IM... 11 " 1875 462 11273900000 729102000 0 " 6214

2 505978 C_COF978M... 11 i 1875 369 11277700000 738558000 50 i 6209

3 505978 C_COF978M... 21 21 1875 am 11277700000 -7.38558000 150 2 6209

4 505978 C_COFS7EM... 31 31 1875 371 11277700000 738558000 330 3 6209

5 210008 C_GSKO0BM... 11 i 1875 381 11264100000 -7.17541000 50 i 6026

6 210008 C_GSKOEM... 21 21 1875 382 11264100000 7.17541000 170 2 6026

7 210008 C_GSKO0EM... 31 a1 1875 383 11264100000 717541000 270 3 6026

8 210012 C_GSKO1ZM... 11 " 1875 390 11266000000 -7.17331000 0 " 6026

] 210012 C_GSKOIZM... 21 21 1875 391 11266000000 -7.17331000 180 21 6026

10 210012 C_GSKDIZM... 31 3 1875 392 11266000000 7.17331000 270 3 6026

n 210037 C_GSKO37M... 11 " 1875 267 11263000000 7.16822000 30 " 6026

12 210037 C_GSKOITM... 21 21 1875 268 11263000000 716822000 140 21 6026

13 210037 C_GSKOI7M... 31 ] 1875 29 11263000000 7.16822000 315 3 6026

i 210056 C_GSKOS6M... 11 11 1875 252 11264000000 -7.15667000 90 " 6026~
J o
W4 » M LLTE

= Apabaila import engineer parameter tidak berhasil pastikan setting regional pada control
panel sudah sesuai.
Cara setting regional yaitu pilih Control Panel>Region and Language>pada tab Format pilih
Additional settings

*# Region and Lingusge 5]
fomats | Loshon | Heyboseds ared Larguaagen | Admitrive

Feemat:

Engish (Unfed Sateal -

Dite ared time ferenats

Frt dates Midiyire &
Long date e, MMM dil vy =
Snem e [ =
Lgmgtima: [ =
Forst duy of week | Sumday zl
Lxamples
St it IS
Long date Tuesday, September 30, 3015
e v 10:55 AN
Long time: 105505 an

Admicnsl settngs .

o ] come

Pada bagian Number pastikan
= Decimal symbol : .

= Digit grouping symbol : ,

= List separator :

= Measurement system : U.S
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P |
Hrbers | Comnancy | Teme | Dae |
Examgle
Positive: 129,45, THS.00 Megative: 125,456, 785,00
Deciemal symibok: [ -

Ho. of digits after decimat F -

Digit grouping ymbok: . -

Dt grouping: 121456.789 -
Hegative sign symbok: - -
Negative rusenbes format: B -
Duiglay leading zeres: 07 -
List separator: . -
esrernent system: [us. -
— [ m—
st native digits [eves -]
S (]
e Lo ][ s

Sedangkan saat import engineer parameter tidak muncul error maka setting regional tidak
perlu dilakukan.
3. Memasukkan Peta
= Pilih View > Outdoor Map (CTRL+m)

[l -0

- —
Ul AaQ oMk LD

lon:113.1176, lat: 5.3630

= Klik Open dan pilih folder Map Surabaya yang sudah disediakan. Select All file dan klik
Open.

* Import peta berhasil apabila muncul tampilan seperti di bawah ini.

[Edowa BEOOX N LT eE
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4. Beberapa parameter yang perlu ditampilkan saat proses drive test diantaranya radio
parameter, serving and neighboring cells, antenna measurement dan throughput. Untuk
menapilkannya pilih View > LTE > pilih beberapa parameter yang ingin ditampilkan (Radio
Parameter, Serving and Neighboring Cells, Antenna Measurement dan Throughput).

Test
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5. Untuk mengecek apakah komputer anda sudah terhubung apa belum ke BTS terdekat silahkan

pilih

View > LTE > pilih parameter yang anda inginkan

ot ans fequency Mesiurement

P MAC UG FOCP R M5 st

HogmergbuenteMmgnen. (o B183]

eERERE

casai. 31

P2 bane togie Combmunean vew Tt Wnsow b

98 B33 808 B9 0 0005 »aaE -

RSSim)
PUSCHPower(dBi)
PUCCHPowerdBn)
RACHPoweroBin)
SRS Pawerdi)

ABE PawerdEm]
Pour Headraamics)
PDCCHLL GrastCount:
'PDCCHDL GrastCoumt
Avarsge SNA(E)
Transmissian Wode
Raric] SNAI)
Raict SNAI(E)
Rari SNR2(d6)
Rarid SNAI(E)
Raic) SNR2(66)
Rarid SNENGE)
Rarct SNRQ(06)
DaRanKISINRIGE)
DesRankZSINR1 8]

o
)
11205

1%
B8
zn

3
]
1

e

s

-ax

BunEn

Pada radio parametémr akan ditampilkan modem terhubung den
hasil tampilan radio parameter menunjukkan bahwa modem terhubung dengan

)
Teng w9 @

Selain itu juga bisa menampilkan parameter throughput.
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6. Setelah Lokasi anda terdeteksi, dan modem sudah tehubung maka

Testing

o =

. Berdasarkan
site PCl 342.

sebelum melakukan drive

test ke lokasi lokasi yang akan anda test, lakukan record atau merekam data yang terjadi
dengan melakukan record (startrecord). Pilih icon start record (F10) dan pilih tempat logfile

yang akan anda simpan.
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7. Setelah Anda melakukan Record logfile, silahkan ke Lokasi yang akan anda targetkan untuk

dilakukan Drive Test.

Contoh: Hasil Drive Test Untuk wilayah PENS dan sekitarnya

[} Project Logfile Configumtion View Iet MWindow Help

‘DB BhAs HOH YU 0 OI DI »OBA M T

e v cRAOF0 @6 QHX A Rm bl

-x

Project

sae verfication

Acceptance

Customas

Control

Cﬂﬂlliytill_ﬂﬂ loncl12.7944, lat: 7.2629
Vi 40 et |

5. Tugas

a. Lakukan drive test jaringan 4G LTE daerah sekitar PENS untuk mengukur kinerja beberapa

.

LA

£ Map Layers vax
+ X2
5 Data Layers
=@ o
% s
Bl Route

parameter KPI yang meliputi accessbility, retainability, mobility dan integrity.

b. Hasil drive test dalam bentuk logfile

c. Dari hasil logfile yang didapatkan, lakukan analisa menggunakan tool Genex Assistant
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